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New Features and Enhancements 2023

Implicit Modeling

A new tab, with the following tools, has been added, allowing you to model with implicit geometry. Instead of explicitly defining the
surface or boundary of an object, implicit modeling represents geometry through implicit functions, defining relationships between points
in space using conditions or constraints. This lets you model complex, irregular, and organic shapes that are extremely lightweight. You
can efficiently manipulate and modify this versatile geometry, perform Booleans and offsets without failure, and model at scale with a
high resolution.
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Primitives Tool
Create simple geometric shapes that can be used for repetitive tasks or combined into more complex shapes. Implicit primitives include
cuboid, cylinder, and sphere. Each primitive type has controllable position, orientation, and dimension.

Surface Lattice Tool

Fill an implicit body with a surface lattice, which is a cellular structure constructed from one or sometimes two surfaces. Rather than
tiling or patterning a base unit cell, the natural repetition of the surfaces creates a lattice-like structure automatically. Popular examples
are Triply Periodic Minimal Surfaces (TPMS), such as the gyroid.
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Planar Lattice Tool
Fill an implicit body with a planar lattice, which is a 2.5D cellular structure with a clearly defined 2D cross-section that is drawn or
extruded along the third dimension. A popular example is a honeycomb structure.

Strut Lattice Tool

Fill an implicit body with a strut lattice, which is constructed from nodes that are connected by beams. Typically, there is a base unit cell
that is tiled or patterned in one, two, or three dimensions to form the overall lattice structure. A popular example is the Body Centred
Cubic lattice.

Point Cloud Tool
Import point clouds or create them from scratch to drive fields or create implicit geometry.
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Field Tool
Create a field to customize an implicit parameter. You can construct a field from a source that is not yet described in a field format and
remap field values to different ranges.

A field is a 3D grid, and each grid point contains a signed scalar value. An illustrative example would be to create a field based on the
signed distance to a plane or line, and then rescale these distances into density values. This field can then be used to control the
relative density of another geometry, such as a lattice, at each location in space.

Convert Tool
Convert parts to implicit geometry. You can select CAD, PolyNURBS, meshes, or optimized parts. The output is typically a Signed
Distance Field (SDF) for the converted geometry.

Move Bodies Tool
Translate and rotate implicit bodies.
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Combine Tool
Combine two implicit bodies into one. A new body is created that envelopes any volume that falls within at least one of the bodies being
combined. It is equivalent to a logical OR/disjunction.

ooV

Subtract Tool
Carve out one or more implicit bodies ("tools") from another implicit body ("target"). A new implicit body is created that envelopes any
volume that falls within any target but not within any tools. It is equivalent to a logical NOT negation.

g

Intersect Tool

Retain only the intersecting portions of two sets of implicit bodies. All the targets are combined to form “Body A,” and then all the tools
are combined to form “Body B.” The result is a new implicit body that envelopes all volume that is inside Body A and inside Body B. It is
equivalent to a logical AND/conjunction.

v
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Offset Tool

Inwardly (negative) or outwardly (positive) offset the surface of an implicit body. The offset surface is always normal to the original
surface. The offset amount can be a constant value, a variable, or a field. Turning on the Shell option will hollow the model and
populate the region between the original and offset surfaces with material.

yve

Invert Tool
Swap the “inside” and “outside” of an implicit body by reversing the sign of all scalar values in the underlying field.

An illustrative example would be to invert the field of a sphere. The result in this case would be a cube that is the size of the bounding
box surrounding the sphere with a spherical cut-out inside of it. The sphere that was once solid is now a void, and the external void
surrounding the original sphere is now solid.

Morph Tool
Morph one implicit body into another and vice versa. Physically separate bodies may not produce meaningful results.

An illustrative example would be to overlay a cube (Body A) and a sphere (Body B). The Morph Value should lie between 0 and 100,
and this controls a linear interpolation between the underlying fields of Bodies A and B. A Morph Amount of 0 would result in a perfect
copy of the cube (Body A), and a Morph Value of 100 would result in a perfect copy of the sphere (Body B). A Morph Value of 50
would produce a new implicit body that has some attributes of both the sphere and a cube—a rounded cube.
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Field driven morph parameters can result in geometry similar to a loft along the field direction.

Smooth Tool
Reduce the size of, or remove, unwanted small and sharp features in an implicit body.

Smoothing is analogous to “blurring” in digital image processing. It operates by moving a window through the underlying field,
performing filtering operations on the field values that fall within the window. Example smoothing filters include Mean, Median,
Gaussian, and Laplacian. Each of these have relative pros and cons, giving different smoothing effects. A second implicit body may
be selected as the Mask, and smoothing will only take place within the volume of this mask.

Fillet Tool
Round edges of implicit bodies to create fillets with a constant or variable radius.

Fillets can be separately applied to convex and concave edges. Unlike traditional CAD, the fillet effect will be applied to any qualifying
edges in the model rather than those that you manually select. The radii can be constant values, variables, or field driven.

A ALTAIR © Altair Engineering, Inc. All Rights Reserved. / altaircom / Nasdaqg: ALTR / Contact Us 6


http://altair.com/

Release Notes / Altair Inspire 2023 :! a LT a I R

Rendering

New Rendering Technology
e All rendering technology has been updated, and there are two new rendering modes available. The new rendering modes and
their distinctive qualities are listed below:

e Performance
e An interactive, physically-based renderer
e High-speed rendering
e  Works on all GPUs

e Quality
e An interactive, ray-tracing based renderer
e Highest quality rendering fully featured with a built in denoiser

e Works only with GPUs with hardware ray-tracing cores available
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Performance and Workflow Improvements
e The user interface for rendering has been simplified to streamline workflow

e New procedural-based materials for intuitive material creation and editing
e Application performance improved to handle larger, more complex models

e Added support for wider range of simulation data

Check for Updates Button to Import Assets

e Materials and Environments assets are now stored online. The new Check for Updates button in the Render library imports the
latest assets to the application.

Render Library X

Check for Updates
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Fluids

Conjugate Heat Transfer

Fluids now offers steady-state Conjugate Heat Transfer simulation (CHT) capability. A steady-state CHT simulation computes the final
equilibrium temperature field inside solids and fluids, and allows heat to pass between fluids and solids. Computing the heat transfer
between fluids and solids provides more accurate results for temperature distribution, heat fluxes, and the overall thermal behavior
within the simulation. By predicting peak and average solid component temperatures, CHT simulations can also assist with the
identification of thermal hotspots and ensuring that the material thermal limits are not violated.

Analysis Exphorer

Steady-state CHT simulations can be performed by selecting the Compute thermal problem and Include solids options under the Run
Fluids Analysis dialog.

Run Fluids Analysis  :ioiiiiiiiiiziiinininiinil X
Simulation Advanced
Mame: CHT_Demol|
v

Resolution 3

Show grid
Compute themal problem
Include solids

Reset  + Run Close

Face Condition

The new Face boundary condition option allows you to specify thermal boundary conditions on the face of a solid or a fluid part. In
addition to a thermal condition, you can also specify a slip-velocity condition on the face. By default, all unspecified surfaces are treated
as adiabatic (thermally insulated) no-slip walls.

®© ©® Q@ ¢

Inlet Outlet Face Part

Conditions Run
Solids = Fuids | Ambient

Select a surface that is not an outlet or aninlet. Cd 2
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Part Condition
The new Part condition option allows you to specify heat sources in solid parts.

® ©® GaQ ¢

Inlet Outlet Face Part

Conditions Run

Select a solid part. then use the microdialog to define the constant heat source.

© Heat source: | Total Power v 400w

Moveable Solid Domains

You can now designate parts in a Fluids analysis as movable solids using the new Moveable Solid Domain tool. Moveable solids are

excluded from the fluid volume identification process. This feature simplifies the process of fluid volume extraction and reduces the
chances of failure.

Convergence Acceleration with Algebraic Multigrid (AMG) Linear Solver
Fluids now offers an AMG linear solver. Enabling AMG can accelerate convergence in certain scenarios with long fluid paths, or when

using a very small voxel size. Activate this feature by selecting the Improve convergence checkbox under the Advanced tab of the Run
Fluids Analysis dialog.

Run Fluids Analysis  D:iiiiiiiiiniinoononiniinis X

Simulation | Advanced

Temination criteria: Physics or equations -

Output frequency steps: 500

Max. time steps 2000

Suface Monitar: Add Sufaces

Flow type: Turbulent »

Cument GPU: RTX AGDOD v
Validate GPL

Reset  « Run Close
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Faster Simulations
Fluids simulations are now up to 2X faster compared to version 2022.3 with more efficient algorithms.

Solver Speed-up

Static Mixer Exhaust Manifold
m2022.3 m2023 m2023-AMG

Fluids Available for Linux

Inspire Fluids is now available for the following Linux operating systems:
e  SUSE Linux Enterprise Server 15 SP3
e Red Hat Enterprise Linux 8.4/Oracle Linux 8.4 or newer

Local Streamlines and Circular Shapes

You can now add local streamlines to a Fluids model after you run an analysis. You can choose to create streamlines in linear or
circular forms and use the microdialog to organize and move the new streamline region. You can also turn off the default inlet
streamlines.
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Geometry

Improved Trim/Split Tool
The Project/Split tool is now named Trim/Split. Use this improved tool to remove part of a surface or solid by projecting a profile curve
onto it. Or use a set of tool surfaces to split a set of target surfaces.

Rib Tool

The new Rib tool provides a convenient way for designers and engineers to add thin-walled features to their models that enhance the
strength and structural integrity of the design. The tool allows you to specify the position, size, shape, and other properties of the rib.
These features can also be parameterized for use in a design table.

Improved NURBS Curve Tool
You can now create a NURBS curve in 3D space by clicking in the modeling window, similar to Blend Curve.

Extend Surface Tool
Use the new Extend Surface tool to extend a surface along one or more edges. You can extend the surface to a curve or another
surface.
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Offset Curves Tool
Use the new Offset Curves tool to create a copy of one or more curves at a specified distance from the source curve. This tool can be
used on both 2D and 3D curves.

Intersect Curves Tool
Use the new Intersect Curves tool to split intersecting curves or wire bodies into several curves, with an option to combine them into
one single curve.

Improved Loft Tool

A new constraint option, Free Tangent Vector, has been added to the microdialog. When you select this option, the loft surface is
made tangent to a selected vector. You can manipulate both the magnitude and direction of the selected vector; if more than

one vector is selected, changes are applied to all.

The Loft tool now tries to match the number of vertices across profiles based on the profile with the highest number of vertices.
When the profile is a periodic curve, you can now select the seam and drag along the curve.

You can now select the profile itself, not just the vertices of the profile, to access the microdialog options.

Improved Multi Sweep Tool
When the profile is a periodic curve, you can now select the seam and drag along the curve.

You can now select the profile itself, not just the vertices of the profile, to access the microdialog options.

Improved Extend Curve Tool
A new option, Create New Part, has been added to the guide panel. Turn on this option to make the extension a new part. You can
also select the edge of a surface or face and extend it as curve. The extension will be a new curve.
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Structure

Report Tools

New Quick Report and Report tools have been added to the Structures tab. They are available after you have run a structural analysis.

Use the Quick Report tool to generate a structural analysis report using the saved settings. You can export as a PPT or PDF. The
report includes material data; model info; run settings; load case info and images; and results. The PPT template can include logos.

Use the Report tool to configure the settings and create a structural analysis report. You can save the settings so they can be used for
quick reports. You can select saved view scenes, select multiple load cases, and select multiple result types to be used for different
runs. You can also save scenes in a .stmod file using the View tool and use these for capturing hotspot views of the model for specific
load cases.

File Edit View Skeich Geometry PolyMesh PolyNURBS Implicit Stucre Motion Fluids Design Explorer Prin3D Manufacture Developer
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5-Axis Milling Optimization Constraint

The 5-axis milling constraint enables optimization results that emulate the capabilities of a 5-axis milling machine, utilizing two

additional rotary axes (A and B) for a multidirectional cutting tool approach. This constraint adds another manufacturing process to the
optimization results.

File Edit View Sketch Geometry PolyMesh PolyNURBS Structure Motion Fluids Design Explorer Manufacture Print3D Developer

Ve RIONET HEL S BB L DD a@

Joints Bushings Connectors SpotWelds Contacts Loads Disps Accels  Materials Masses  Systems Shape Controls Bead Patterns Analyze  Optimize
Home Connections

Setup

S S L

Single SpliDaw Radial Exirusion Overhang  Milling
Draw

Run

Select a design space. 2
Ctrl+ 8 Addjremove from selection

Del Delete milling,
F1 Show Help

SimSolid Contact Finding for Solid
The SimSolid contact algorithm has been incorporated for faster contact find and support of part pairs.

Old

New
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Bolt Pretension Added to the SimSolid Analysis
Bolt pretension is now supported for SimSolid, allowing you to obtain more accurate results within the bolts.
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Apply Boundary Conditions to Mesh Features
You can now apply boundary conditions to mesh parts from STL models and run analyses in SimSolid

calculated for mesh or mixed CAD/mesh models.

. Additionally, contacts are

TagRo. 08 aa
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Apply Grounded Bushings to Multiple Part Features for OptiStruct
You can now apply grounded bushings to multiple part features for OptiStruct. This allows for more connections conditions

for OptiStruct models.

A A

X | 353521363 e
b 65T em
Fid 00sm

PolyMesh

Fill and Convert Tools Removed
The Fill and Convert tools have been removed as improved, richer filing and conversion functionalities are now available through

Implicit Modeling.
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Porosity Analysis Enhancements
e  Porosity analysis now supports .stl files.

e The Materials menu now includes the entire materials library, including alloys.

Run Analysis :iiiiiiiiniiiiiiiiiin X
MName: +10_degrees
Element Size: 0003 m
(@ Aluminium  + A7075 v

Aluminium &

s ~sthron I}

Cobalt

Copper

Gold

Magnesium

Mickel

Silver v

e Results include a wider array of result types.
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Materials Window
The Materials Window now includes a tab for Powder properties, including Conductivity, Density, and Specific Heat.

Materials iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiniiiiiiiiiiniiniinoX
Materials Database - My Materials
Material Name Aluminum AISi10Mg ¥
General  Thermal . Mechanical . Powder
Density ¥
Conductivity
‘Density [,
Specific Heat -
129315 13150
253315 12918
377315 12686
4 82315 12289
5 88565 1188.0
6 91065 11857
792315 11845
1320 -
1300 -
& 1280 -
E
5 1260 -
2 1240 -
2
& 1220
1200 -
1180 -
3;}0 4;}0 5;}0 6;}0 ?il}u 8;}0 9;}0
Temperature
Select Import Export Edit
General

Improved View Tool
The View tool has been improved to include the view state of all objects in the model, such as parts, loads, fasteners, and sections.
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Section Planes

You can now create a section cut on a selection of parts while allowing others to remain undisturbed. This works together with the View
and Report tools to automate documentation workflows.

Import of .3mf Files
You can now import .3mf files into Inspire.
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Improved Import Functionality for Variable Manager
Now when you import variables, by default they are merged with any existing variables. To clear existing variables on import, in the
Variable Manager dialog box, from the hamburger menu, turn on Clear Variables on Import.

Design Explorer

Linux Support
Design Explorer is now supported on Linux.

e  SUSE Linux Enterprise Server 15 SP3
e Red Hat Enterprise Linux 8.4/Oracle Linux 8.4 or newer

Extract Non-Solver Responses
You can now execute a run when there are only model responses, no solver responses.
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Motion

Multi-Signal Profiles

With this new addition to the input types in the Profile Editor, you can create complex input profiles that are comprised of multiple
signals in the same input. Previously, inputs were limited to single functions, such as Step, Step-Dwell-Step, and sinusoidal, and to
create complex expressions, solver expressions had to be manually written. Now, you can quickly and easily create such expressions
using an interactive interface inside the Profile Editor.

(3T T/5[=:T i+ 7 BB0886000600606000006000000060860008800000060660060600000006066000000000000060000006000000000600000000000008 " £al
Function:  7_ + m Actuator 6 - Displacement
Signal: 00 i
Value: 13.0mm
Start Time: 02s| |Rel |+ =l Signal 2
Duration: 05s =T
Y = 20.687
Convert to Table
200 r
)
E
E 150
£
o
5
Signal Edit 10.0 4
1 Step
2 Step v (] 50
3 Step -
00 —
0 05 1 15 2
Time (s)
End Time: 208 | # 1 2 5 0 30 60
Fit Orchestrate | Output Rate: 300 Hz 10 30 50 100 300 500

New Joint Graphics

Joints are no longer represented only as highlighted surfaces, but now more closely represent the type of physical connection and its
degrees of freedom. These new joint graphics are the same as the graphics used by Altair MotionView.

Q=m0 ?

Hinge Cylindrical Planar Translational Ball & Socket Unknown Contact

Selecting a joint graphic will display a sizing manipulator so you can adjust the visible size of the icon.
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New Joint Creation Option

You can now create joints by selecting one or more parts individually, then gradually walking through the model. Previously, to reduce
search times for joint features, you would need to hide all other parts and show only those related to the joint. Now, there are two
options on the guide bar for creating joints: All Parts and Select Parts.

All Parts works the same as it did previously, but the Find function is no longer automatic. You need to click the Find button to search
the model. With Select Parts, you can select two parts, for example, and only the joint feature candidates between those two parts will
be shown. This allows for a more gradual approach to building models. It also prevents long joint feature search times.

» Find : Al v < | = | Aduo > KX

1
; _h all parts for fleatures. or use Select Parts to walk through the model.
: 1

New Joint Edit Option

Joint location and orientation can now be changed using an integrated Move tool on the joint micro dialog. The option to reset is also
available. The joint can be changed to any type regardless of the type of joint Inspire creates based on detected geometry.

oy

DX [01227m|
Y [0a77m
: Z|[0151m

Move
Translate or rotate using the Move tool.

List Table for Flex Bodies

A table is now available for flexible bodies. The table contains an organized layout of the parameters associated with flex bodies, such
as the number of modes, Faster/More accurate, and more.

Name - Flexible Bady Flexbody Element Order Nomal Modes Frequency Type exbody Stress Calculatio Flexbody Strain Calculation
ﬁ Link Crank More accurate 15 Mormal Modes Al None
A Link Dual Siot
& Link Single Slot
W Mount Clevis
u Mount Crank

Faster 10 Nomal Modes Al None

(<M< <]

Faster 10 Nomal Modes Al None

Run History Access

Run history data can now be plotted without loading a model using a new, temporary satellite icon that opens the Plot Manager. After a
model is loaded and solved for the first time, the icon is replaced with a blue check mark. After the icon changes to a blue check mark,
the Run History can only be accessed from the Plot Manager.

falyes Mokon Analyze Motion

Flex Body Meshing Improvements
Significant improvements have been made to prevent the failed creation of flex bodies.
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Python API

General

New APIs for store and recall views have been added.

Geometry

Added Rib capabilities: Now you can create thin-walled features of your models that enhance the strength and structural
integrity of the design.

Added Extend Surface capabilities: Now you can extend the surface up to a curve or another surface.

Added Offset Curves capabilities: Now you can offset the curves at a specified distance from the source curve.

Added Intersect Curves capabilities: Now you can split intersecting curves or wire bodies into several curves, with an option to
combine them into a single curve.

Added Extend Curve capabilities: Now you can extend a 3D curve or a wire body.

Added Blend Curve capabilities: Now you can create a free-form curve that blends into one or more existing curves, surfaces,
or edges.

Added Face Curve capabilities: Now you can extract curves from a face in the U or V direction.

Added Trim and Split capabilities: Now you can remove part of a surface or solid by projecting a profile curve onto it.

Implicit Modeling

Extensive APIs for generating and editing implicit components have been added. Now you can quickly model complicated,
irregular, and organic forms.

Structures

Added an API for the 5-axis milling constraint.
APIs for the Report tool have been added. You may now use it to build your own reports.
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Enhancements

e Added enforced displacements on a cylindrical hole [IN-31780]

e  API support for the Extend Surface tool [IN-31698]

e A geometry import option was added to properly support point names [IN-30298]

e Added the ability to add/remove parts from Section Cuts [IN-9456]

e Added variable support to the Partition [IN-31142], Fillet Edges [IN-31140], NURBS Curve [IN-31139], Helix Curve [IN-31138],
sketch patterns [IN-30905], Offset [IN-31144], and Geometry Simplify tools [IN-31141]

e Allowed the Extract tool to extract lines and points from reference lines and points [IN-30709]

e  Applied Symmetry and Extrusion shape controls in the same optimization run [IN-30659]

e  Grounded bushings can now connect multiple cylindrical faces through multiple parts [ IN-30299]

Resolved Issues

e Inspire no longer performs a 30-unit license checkout to turn on Print3D Ul [IN-33014, IN-32940]
e Fixed File New crash after isolating the part in the simulate context when the model contains measures [IN-33386]
e Fixed a crash when opening a file containing a PolyNURBS part [IN-31381]

e Fixed a crash when opening a file containing corrupted data from a 2022.2 file [IN-33087]

o  Fixed callout ignored with 2" order elements [IN-32845]

e Fixed Japanese wording [IN-32392]

e Fixed contact not being found after geometry was read with surface errors [IN-32326]

e Fixed a crash when saving a file under a different name [IN-32121]

e Fixed model view center moving upon rotation [IN-31374]

e Fixed View Cube for Dark mode [IN-30643]

e Fixed STEP file import translations [IN-31130]

e Fixed forces not being applied perpendicular to faces [IN-31713]

e Fixed grounded bushings for modal analysis [IN-30848]

o Fixed fastener shear and axial response [IN-29631]

Known Issues

e  Pre-highlighting issues in post-processing results [IN-24980]

e Modifying edge fillet leads to selection of additional edges [IN-27932]

e Hidden edges appear in many tools [IN-32396]

e Snap to visible still allowing some “hidden” snaps to be selected [IN-33450]

e View Cube doesn’t appear correctly using AMD graphics card [IN-32550]

e When assigning a material and enabling Performance Render within the Print 3D tab, there is no effect on the visualization
[INP-2092]

e  When Model units are set to MMKS, Eigen Analysis results are graphically incorrect. However, the numerical Mode results are
correct. For now, users can run an Eigen analysis using MKS Model units (under Preferences). A second option is to use
MMKS Model units, and then open the resulting .H3D in HyperView. [IM-4658]

e Min/Max flags and Callout flags inside flex body results review context are not being displayed when using MMKS Model units
(under Preferences). [IM-4952]

e Power output results are being scaled incorrectly when using MKS Model units (under Preferences). For now, it is suggested
to use MMKS Model units when seeking Power results for Motors and Actuators. [IM-4916]

e When loading Analyze Part results from previous versions, there may be an increase in the time it takes to load the results. A
warning message will appear, giving the option to either proceed with loading or cancel, where it may be faster to run a new
Motion + Analyze Part. [IM-4940]
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Learn More About Inspire

You can learn more about new and existing features in Inspire using the following resources:

In-Application User Assistance
Inspire provides two types of user assistance. Enhanced tooltips appear when you hover over icons and other features. They describe
what the tool does.

U bl

Mirrc
Patch

Fill in missing surfaces, or remove and
remake problematic surfaces.

43 Press F1 for more help.

Workflow help appears when you select a tool that opens a guide bar or microdialog. The text prompts you what to do next.

E| Find | & | = | K » Partition All

Click a selected feature to partiion it =4 ¥

A
Click ™ to view additional tips and shortcuts. Some tools also include a video =)

= Find — - [ » Partition All

Click a selected feature to partitionit =4 2

Holes and pockets are automatically selected
and shown in red, but you can manually select
faces as well.

! Partition a selected feature.
Ctr+@  Addfremove from selection.
Del Remove a partition.

F1 Show Help
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Online and Offline Help

Press F1 or select File > Help > Help to view the online help.

Altair Inspire™

] -~
' g4 o o8 ‘ _/“‘
What's New Get Started Tutorials
Discover new features and New to Inspire? Learn the basics Start using Inspire with our
enhancements. here. interactive tutorials.

You can download an offline version by selecting File > Help > Download Offline Help. An internet connection is required to
download.

D New Help Options
] open.. Help ..
Open the help for Inspire
Open Recent > =
Download Offline Help
Import... Download and install offline help for Inspire
Tutonals...
C Download and install offine help for Inspire |
POM ¥ | What's New___
Read aboutthe latest enhancements
- About Inspire
Save As... Display importantinformation about Inspire
Contact Support

Contact Altair support
Screen Capture  »

Help >
Licensing

Preferences ... Exit

Supported Languages

The language for the user interface and online help can be changed in the Preferences under Workspace > Language. User interface
text is available in English, Chinese, French, German, Italian, Japanese, Korean, Portuguese, and Spanish.

The online and offline help is available in English at the time of release, and in Chinese, Japanese, and Korean generally 1 to 2 months
after release. If a language is selected in the Preferences that is supported for the user interface text but not for the help, the English
help is shown. Similarly, if an unsupported language is selected in the Download Offline Help dialog, the English offline help will be
downloaded instead.
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